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Thank you for your interest in Dostek DNC products. This guide includes a brief description of:

• Dostek DNC software

• Dostek Model 440A Behind-the-Tape Reader (BTR)

• Third-party serial communication boards, hubs and adapters available from Dostek.

Product brochures are available for download at:

www.dostek.com/brochure      (<- Click link to open web page)

Prices are quoted in US Dollars. Taxes, duties, shipping and handling are extra. Prices are subject
to change without notice.

To place an order, or to obtain more information, contact Dostek by telephone at 1-888-355-5735
(toll free, USA and Canada) or 519-742-5721, or by email at sales@dostek.com.

How to Use This Document

When viewing this document on your computer (using Adobe Acrobat Reader), you may view a
table of contents, print all or part of the document, search for text, or zoom in to view detail.
Following is a list of some useful Acrobat Reader commands:

Click Fit width in the View menu.Zoom to Page Width

Click Fit page in the View menu.Zoom to Full Page

Click Zoom in the View menu.Zoom In

Click Find in the Edit menu.Search Text

Click Print in the File menu.Print Pages

Click a heading in the Table of Contents (Bookmarks).Jump to Section

Click Show bookmarks in Window menu.View Table of Contents

Acrobat Reader CommandFunction
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1. Dostek DNC Software

Dostek DNC software includes an Explorer-style file manager, a multiple-document program
editor, two DNC communication applications ("classic" and "remote callup server"), several
supplementary applications, and document and help files.

Dostek DNC is available in three editions covering the entire range of DNC applications:

• Lite Edition
• Professional Edition
• Ultimate Edition

Editions differ in:

• The number of CNCs you can connect for remote call-up or simultaneous drip-feeding.
• Advanced features, including file comparison and searching.
• The amount of free remote and telephone technical support provided.

You can connect all your CNCs to one computer, or you can connect each CNC or work cell (group
of CNCs) to a separate computer. A separate software license is required for each computer. 
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10-504010-500010-5010Order number

$295.00$145.00$95.00Cost (each additional computer)

$795.00$495.00$295.00Cost (first computer)

YesYesNoAdvanced searching

YesYesNoSide-by-side file comparison

881Classic drip-feed, max CNCs

64161Remote call-up, max CNCs

Ultimate
Edition

Professional
Edition

Lite
EditionFEATURE COMPARISON



With Dostek DNC, you can:

• Load a part program into the CNC's memory from a computer file.

• Run (drip feed) a part program on the CNC directly from a computer file. (Providing the CNC is
capable of running a program from the RS-232C serial port or tape reader).

• Save a part program from the CNC's memory to a computer file.

• Load and save CNC data, such as tool offsets, machine parameters, and eve machine
executive software.

You can use Dostek DNC for "classic" communication or for "remote callup." The main differences
are:

• With classic communication, you select a file or folder on the computer, and then go to the
CNC and execute a load, run (drip feed) or save command to complete the transfer.

• With remote callup, there is no need to leave the CNC. The Dostek DNC software continuously
monitors all CNCs. To save a file from the CNC to the computer, you simply punch it. To load
or run a program from the computer, you first send a short "command" program from the CNC
to the computer. For example, to load or run file "A1234," you might first send a command
like this from the CNC to the computer:

O7999 (DNC REMOTE CALLUP)
(LOAD A1234)

• With classic communication, each transfer occurs in a separate window, and each window
scrolls the data during the transfer so you can monitor progress in great detail.

• With remote transfers, all transfers occur in the same window, one per line, and only the
status of the transfer is displayed (data is not scrolled). This greatly reduces computing
overhead and allows simultaneous communication with up to 64 CNCs.

• Remote callup eliminates the need for shop-floor computers. One computer services up to 64
CNCs, and the computer can be located in the office or a secure computer room.

• To use remote callup, each CNC must be connected to a separate computer COM port. With
classic communication, you can use a switch box to share one COM port with several CNCs.

Lite Edition is ideal for basic DNC applications. You can connect any number of CNCs to the
computer, but you can communicate (load, run or save) with only one CNC at a time.

Professional Edition and Ultimate Edition let you communicate with multiple CNCs at the same
time, and include advanced features including searching and side-by-side file comparison. You can
use classic communication with up to 8 CNCs at a time, or use remote call-up with up to 16
(Professional) or 64 (Ultimate) CNCs.        
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1.1 How it Works

You can use Dostek DNC for "classic" communication or for "remote callup."

Classic DNC

Loading a file to the CNC using the "classic" DNC method is a simple 3-step process.

Step 1. At the computer, start the Dostek DNC File Manager and then select a file.

Step 2. Click the "Send" button.

Step 3. Go to the CNC machine and execute a "Read" or "Input" command.

Notes:

File Manager
› With the Dostek DNC File Manager, you can organize your files however you like. You

decide which folders to make available, and you can choose folders on the local hard
drive, any network drive (mapped drive or UNC name), or any removable media. 

› Files for the current folder are displayed in the right window. The advanced search
function lets you find files by name, by date or by file contents. For example, you can
find all files that contain a certain part number or tool, and even view a list of the lines in
each file that contain the search text. 

› The buttons shown along the right edge of the File Manager window above can be
customized to suit your preferences. You can choose from 4 button sizes, customize the
colors, specify the commands and button legends, and even create buttons that launch
other applications.

Communication

› The Communication window lets you preview the file before you start sending, and lets
you start or restart from anywhere in the file. A pop-up window can remind the operator
of the command sequence required at the machine to load the files.  If you select
multiple files, they'll be queued so they all load in a single operation.

Convenience

› With most CNC machines, you don't need to type in the program number when loading
or saving a program. When sending to the CNC, Dostek DNC detects when the machine
is ready to receive and starts sending automatically; there's no need to walk back and
forth between the computer and machine.

Drip Feeding

› When you're drip feeding, Dostek DNC scrolls the program on the screen so you can see
where you are and what's coming next. And you can stop anytime and restart from
another position. When the end of the program is reached, you can automatically restart
from the beginning to run multiple parts.
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Remote Callup

Loading a file to the CNC using the "remote" DNC method is a simple 3-step process.

Step 1. At the CNC, create (or edit) a designated "command" file to include a simple one-line
command string. For example, to load file "A7-53759", the CNC operator creates:

O7990
(SEND A7-53759)

Step 2. Punch the designated "command" file, and wait 5 seconds for the computer to receive
and process the command. The computer prepares to send the requested file.

Step 3. Execute a "Read" or "Input" command on the CNC  to load the part program into
memory, or execute a  "Cycle Start" (or similar) command on the CNC to drip feed the
part program directly from the computer. The computer detects that the CNC is ready
to receive data and starts sending the file.

Notes:

› Remote callup uses the Dostek DNC Remote Server application, which continuously
monitors all CNCs.

› A single computer can simultaneously serve up to 64 CNCs, and multiple computers can
be used to serve a virtually unlimited number of CNCs.

› Because remote access requires continuous monitoring of all CNCs, each CNC must be
connected to the computer by a separate COM port. 

Page 5 Toll free 1-888-355-5735
www.dostek.com

DOSTEK



2. Behind-the-Tape Reader (BTR)

The Dostek Model 440A Behind-the-Tape
Reader (BTR) is an affordable RS-232
serial communication retrofit for older
NC/CNC machine tools equipped with tape
readers. It lets you integrate older NC
machine tools into a modern DNC system
for loading or drip feeding of part
programs or executive software directly
from computer. 

256Kb battery-backed memory is included
for file storage. You can use the memory
to run the same program over and over
again, or to continuously drip feed files of
unlimited size.

The 440A BTR lets you load or run standard ISO or EIA part program files or binary files such as
machine executive software and diagnostics. Standard parallel (Facit) and serial (RS-232/current
loop) puncher ports let you send data from the CNC's punch output back to the computer.

The 440A BTR is available for a special low price of only $695 for prepaid orders. A CNC adapter
kit is required for some applications (see table, below). An optional punch adapter cable may be
required to connect the CNC tape punch output to the 440A BTR parallel or serial punch input
connector.

(1)US Dollars, taxes and duties extra, subject to change without notice.
(2)Discounted price is available for PREPAID orders only; certain conditions apply (please call for
details). Dostek accepts pre-payment by Visa, Mastercard, PayPal (includes Amex), bank wire
transfer or company check. 
(3)Toll-free telephone technical support is free for 60 days from date of purchase. Support by email
is always free. 

Each 440A BTR also includes:
TOLL-FREE TELEPHONE TECHNICAL SUPPORT(3)

Dostek DNC software, BTR Edition, (file manager, editor, communication)
1-year limited warranty

$50$50Shipping (USA and Canada)

$60Please call

Optional punch adapter kit.
May be required to use BTR
for sending files from CNC

back to computer.

$80-$120Please call

CNC adapter kit. Not
required for Fanuc, Sanyo

Denki 2601 and most
Remex, EECO and Decitek
replacement applications.

$695$99510-0440ABTR Communication
Interface

440A

Prepaid(2)Price(1)Order NumberDescriptionModel

Dostek 440A Behind-the-Tape Reader (BTR)
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3. Communication Hardware

This section recommends communication products that work well for CNC communication.

To use Dostek DNC's remote callup feature, each CNC machine must be connected to a separate
COM port.

The following table describes common types of Windows-compatible RS-232C communication
hardware.

Notes:
› You can use a combination of communication hardware types.
› Be careful when choosing communication hardware. Some brands or models

do not work well for CNC communication due to hardware and software design
flaws.

Serial boards plug into the computer's expansion slot. Once
common, they are now rarely used due to potential
compatibility and maintenance problems.

Multi-port serial board

You can install a wireless Ethernet/serial adapter at each
CNC to eliminate wiring. You must also install one or more
wireless access points to provide shop-floor wireless
coverage.

Wireless Ethernet/serial
adapter

Wired Ethernet/serial adapters are available with 1, 4 or 8
serial COM ports. Ethernet/serial adapters plug into the
network, not directly to the computer. You can install the
adapters on the shop floor to reduce cabling cost and
improve reliability.

Wired Ethernet/serial
adapter

Dostek currently does not recommend using USB/serial
adapters. Of the products tested, ALL have bugs in their
device driver or firmware that cause problems for CNC
communication.

USB/serial adapter

If your computer is equipped with a built-in serial COM port,
you can connect one CNC to the computer, or you can use a
mechanical switch box to connect 4 or more CNCs to the
computer

Computer's built-in serial
COM port

Communication Hardware
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3.1 Recommended Single-Port Communication Hardware

Dostek recommends single-port wired or wireless Ethernet/serial adapters. They provide electrical
isolation to reduce the risk of damage caused by electrical surges.

RS-232C signals are grounded. When you use multiple-port boards or hubs, the ground wires from
all CNCs are connected together at the computer or hub. Communication problems or electrical
damage can occur if any machine is improperly grounded or an electrical surge occurs.

With both wired and wireless single-port Ethernet/serial adapters, the CNC machines are
electrically isolated from the computer and from each other.

Also, the lower cost of single-port adapters makes it affordable to keep a spare unit on hand to
eliminate downtime due to equipment failure. 

Moxa NPort Wired Ethernet/Serial Adapter ($150, order #10-2401)

The Moxa NPort wired Ethernet/serial adapter plugs in to your
computer network and provides a standard DE9P RS-232C serial
port. You can connect any number of NPort 5110 Ethernet/serial
adapters to your computer.

The NPort adapter provides 1500 volts of magnetic electrical
isolation on the Ethernet port, and 15000 volts electrostatic
protection on the RS-232C signals. 

To use the NPort adapter, you:

• install the adapter in, on or near the CNC machine

• plug the adapter's power cable into a standard power plug

• install a Category 5 network cable between the adapter's
RJ45 network port and your LAN switch or hub

• install a short RS-232C serial cable between the adapter's DE9P serial connector and the
CNC's RS-232C serial port

• install the Moxa device driver software on the computer, and then assign a static IP address
and COM port number to the device

The NPort adapter is covered by Moxa's limited 5-year warranty.  
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Moxa NPort Wireless Ethernet/Serial Adapter ($350, order #10-2601)

The Moxa NPort wireless Ethernet/serial adapter connects to your
802.11 wireless network, and provides a standard DE9P RS-232C
serial port. You can connect any number of NPort wireless
adapters to your computer. 

The NPort wireless adapter works with your wireless access
points, and provides a wireless range of up to 100 meters in
open areas. It provides total electrical isolation and 15000 volts
electrostatic protection on the RS-232C signals. 

To use the NPort wireless Ethernet/serial adapter, you:

• install the adapter on or near the CNC machine

• plug the adapter's power cable into a standard power plug

• install a short RS-232C serial cable between the adapter's
DE9P serial connector and the CNC's RS-232C serial port

• install the Moxa device driver software on the computer, and
then assign a static IP address and COM port number to the
adapter

The NPort wireless adapter is covered by Moxa's limited 5-year warranty.
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3.2 Multiple-Port Ethernet/Serial Hubs

Multiple-port Ethernet/serial hubs are an affordable
way to replace older systems and continue using
existing cabling. However, single-port wired or
wireless Ethernet/serial adapters are a better
choice because of the electrical isolation they
provide.  

The 4-port and 8-port Ethernet/serial hubs provide
standard DE9P RS-232C serial COM ports. The
hubs connect to your local area network (LAN)
using standard Category 5 network cable up to 300
feet in length. A 'virtual' COM port driver installed
on the computer handles the transfer of COM port data between the computer and hub over the
network.

$6958-port Ethernet/serial hub with surge suppression10-2208-SS

$6258-port Ethernet/serial hub10-2208

$4654-port Ethernet/serial hub with surge suppression10-2204-SS

$4254-port Ethernet/serial hub10-2204

Ethernet/serial Hubs

3.3 Multiple-Port Serial Boards

Multiple-port serial boards are an inexpensive way to add
COM ports to a computer. Disadvantages include:

• No electrical isolation; all machines are connected to
a common ground.

• Some computers may not have a compatible plug-in
slot available. 

$1958-port PCI serial board
Bus: PCI / PCI-X (5 / 3.3V)

10-2508

$602-port PCI serial board
Bus: PCI (5V)

10-2502

Serial Boards
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4. Cables and Wiring Accessories

Dostek offers a complete range of cables and wiring accessories. Please call Dostek at
1-888-355-5735 (toll free, USA and Canada) to discuss your requirements.

Economy CNC Communication Cable ($30/$40)

The Dostek 60-2555-10 (10 feet, $30) and 60-2555-25 (25 feet, $40) cables are cross-linked null
modem cables ideal for most CNC communication applications. These cables provide a DE9S
(socket) connector for connecting to the computer, and a DB25P (plug) connector for connecting
to the CNC.

Custom CNC Communication Cable ($79 and up)

The Dostek 60-2550 CNC communication cable is available in two standard lengths: 25 feet
(60-2550-25 :: $79) and 50 feet (60-2550-50 :: $99). The DE9S connector on one end plugs into
a standard computer COM port, and the DB25P connector on the other end plugs into most
common CNC models. Other lengths and wiring configurations are available.

RS-232 to Category 5 Wiring Adapters ($22)

Inexpensive and readily-available Category 5 cable (widely used for
10/100-Base-T local area network wiring) can be used with wiring
adapters to connect the computer and CNC serial ports. Although
adapters are available online and from many computer and electronic
stores, they require some soldering and assembly to work with most
CNC models. Pre-wired and assembled  RJ45/DE9 and RJ45/DB25
adapters are available from Dostek for only $22 each (quantity discount
available).

RS-232 Test Kit ($79, order #80-5911)

The RS-232 Test Kit includes a full set of the tools and adapters needed to
monitor and troubleshoot RS-232 serial communication: one each RS-232
Mini Tester,  9/25 adapter, 25/9 adapter, 9-pin loopback adapter, 25-pin
loopback adapter, and two gender changers.

The RS-232 Mini Tester provides LED indicators to display the status of
each of the RS-232 signals. The loopback adapters connect the RS-232
output signals back to the input signals so the computer can test for proper operation of the
computer COM port and cables. The 9/25 and 25/9 adapters let you use the Mini Tester with both
25-pin and 9-pin serial ports and cables.

5. Services :: Installation, Repair, Tape Conversion

Dostek offers a full range of professional services including DNC system design, installation,
training and repair, as well as specialized services such as punched-tape duplication and
transcription to computer disk files.

Remote Training and Assistance

Remote service puts Dostek's technical expertise to work for you as a timely and affordable
alternative to costly on-site service calls. For new customers, Dostek can remotely install and
configure your software, show you how to use it, and help you test communication with your
CNCs. For existing customers, Dostek can help you hook up a new machine or quickly diagnose a
problem and get you back up and running. To take advantage of remote service, all you need is a
high-speed Internet connection and a telephone.     

Page 11 Toll free 1-888-355-5735
www.dostek.com

DOSTEK



6. How to Order

To place an order or request a quotation, please contact Dostek.

6.1 Payment Methods

Dostek accepts payment by Visa, Mastercard, PayPal, purchase order or
bank funds transfer.

Visa and Mastercard. Order by telephone or fax using your credit card.
For your security, Dostek does not electronically store credit card
information. Credit card payment may not be available for some orders
destined outside USA and Canada.

PayPal. Using the PayPalTM online payment system is easy and secure. A PayPal account is not
required. When you receive your detailed PayPal invoice by email, simply click the link and enter
your payment information. PayPal payment options include Visa, Mastercard, your PayPal funds or
registered bank account, or some American Express cards (according to the PayPal Web site,
American Express does not permit use of corporate cards with PayPal).

Corporate purchase order. Subject to prior credit approval by Dostek.

Bank Funds Transfer. Inter-bank wire payment is available for orders delivered outside USA and
Canada. 

6.2 Shipping

Dostek ships all orders by UPS. Please contact Dostek for current shipping rates.

6.3 Returns/Refunds

All sales are final. However, returns and refunds may be considered when warranted.

To ensure your purchase is suitable for your application:

• Contact Dostek to discuss your needs. 

• Download a free trial copy to evaluate software before you decide.

• Take advantage of Dostek's free technical support during your software trial.

To return a product, contact Dostek to obtain authorization. Unauthorized returns are not
accepted. A restocking fee may apply.
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sales@dostek.comEmail:

519-741-8669Facsimile:

519-742-5721Telephone:

888-355-5735 (USA and Canada)Toll free:

Contact Dostek
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